# Table of contents

1 Introduction .......................................................................................................................... 1

2 System Requirements .......................................................................................................... 1

3 Installation and System Setup .............................................................................................. 2

4 Starting Diagnostic Suite ...................................................................................................... 5
   4.1 Start from Noah .......................................................................................................... 5
   4.2 Start from OtoAccess™ ............................................................................................... 6
   4.3 Start as Standalone .................................................................................................... 6

5 Audiometry Data Transfer .................................................................................................... 7
   5.1 Instrument Setup ........................................................................................................ 7
   5.2 Quick Start - Transferring Measurement Data ........................................................... 10
   5.3 Main Functions and Features .................................................................................... 14
   5.4 The Diagnostic Suite Audiometry Menu Items ........................................................... 17
      5.4.1 Print .................................................................................................................. 17
      5.4.2 Edit ................................................................................................................... 17
      5.4.3 View ................................................................................................................. 18
      5.4.4 Tests ................................................................................................................ 18
      5.4.5 Setup ................................................................................................................ 18
   5.5 Main Setup ............................................................................................................... 19
      5.5.1 General Tab Page ............................................................................................ 19
      5.5.2 Tone Audiometry Tab Page .............................................................................. 20
   5.6 General Setup .............................................................................................................. 21

6 Diagnostic Suite with AD629 .............................................................................................. 23
   6.1 Instrument Setup ...................................................................................................... 23
   6.2 License Options ........................................................................................................ 23
   6.3 SYNC Mode (Patient/Session Transfer) .................................................................... 24
      6.3.1 Client Upload .................................................................................................... 25
      6.3.2 Session Download ............................................................................................ 26
      6.3.3 One Click Data Transfer (latest saved session) ................................................ 27
   6.4 Hybrid (Online/PC-Controlled) Mode ......................................................................... 28

7 Tympanometry Data ........................................................................................................... 30
   7.1 Instrument Setup ...................................................................................................... 30
7.2 Quick Start – Transferring and Saving Tympanometry Data .....................................33
7.3 Main Functions and Features....................................................................................35
7.4 The Diagnostic Suite Tympanometry Menu Items.....................................................37
  7.4.1 Print .................................................................................................................37
  7.4.2 Edit ..................................................................................................................37
  7.4.3 Setup ................................................................................................................37
  7.4.4 Help ................................................................................................................37
8 Reports and Printouts ........................................................................................................38
  8.1 The Print Wizard ...................................................................................................38
  8.2 Getting Started......................................................................................................39
  8.3 Designing an Individual Printout ..........................................................................40
  8.4 Formatting a Print Layout .....................................................................................43
  8.5 Making Reports ....................................................................................................45
  8.6 Getting Started......................................................................................................45
  8.7 Creating a Report Template ..................................................................................48
  8.8 Menu Items ..........................................................................................................49
    8.8.1 The File Menu ...............................................................................................49
    8.8.2 The Edit Menu ..............................................................................................50
    8.8.3 The Insert Menu .........................................................................................51
  8.9 Importing and Exporting a Report Template ..........................................................52
    8.9.1 Importing a Report Template .......................................................................52
    8.9.2 Exporting a Report Template ......................................................................52
9 The AD629 Audiometry Module in Hybrid Mode ..........................................................53
  9.1 AC440 Tests .........................................................................................................53
    9.1.1 Air Conduction Audiometry ..........................................................................53
      9.1.1.1 High Frequency Audiometry ..................................................................53
    9.1.2 Bone Conduction Audiometry ......................................................................53
    9.1.3 Free Field Audiometry ..................................................................................54
    9.1.4 Speech Audiometry ......................................................................................54
    9.1.5 Masking ........................................................................................................54
  9.2 Using the Tone Screen ...........................................................................................55
  9.3 Using the Speech Screen .......................................................................................62
    9.3.1 Speech Audiometry in Graph Mode ...............................................................68
    9.3.2 Speech Audiometry in Table mode ...............................................................69
      9.3.2.1 The SRT Table .......................................................................................69
1 Introduction
This manual describes the Diagnostic Suite software used for transferring audiometric and tympanometry data from the Interacoustics standalone audiometers to the PC. The Diagnostic Suite allows users to display, store and print audiometric data.

2 System Requirements
- Operating systems support:
  - Windows® XP SP2 and Vista.
    Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
- Database support:
  - Noah3 and OtoAccess™
- Instrument support:
  - AS608e, AD226, AD229b/e, AD629(b/e), AC33, AC40, AT235, AA222, MT10.
- Instrument to PC connection support:
  - AS608e and AD629 uses a direct USB connection (it has build-in USB)
  - AD226, AD229b/e, AC40, AT235 and AA222 use the UCA40 USB-serial converter/adapter.
  - AC33 uses a direct serial (com-port) connection (since it does not support the UCA40 adapter).
- Test measurement data support:
  - Audiometric data: Air, Bone, Speech
  - Tympanometry data: Tympanogram, Acoustic Reflex, Eustachian tube function test for the non-perforated eardrum (ETF1) and perforated eardrum (ETF2)
- On-line/PC-operated mode and Patient/Session transfer to database:
  - Only supported by AD629.
3 Installation and System Setup

The Diagnostic Suite can be installed with either OtoAccess™ or Noah or run as a standalone application.

To install Diagnostic Suite simply insert the installation CD run the installation file (if it does not start automatically) and following the installation:

1) Welcome Dialog: Press Next

## Welcome to the Diagnostic Suite Setup Wizard

The installer will guide you through the steps required to install Diagnostic Suite on your computer.

**WARNING:** This computer program is protected by copyright law and international treaties. Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

2) Select Installation Folder: Press Next
3) Confirm Installation: Press Next

4) Wait for installation to complete
5) Installation is complete. Press “Close”.

6) Then proceed to system setup described in the next chapter.

Once the Diagnostic suite has been installed, it can be launched from either Noah or OtoAccess™ depending on the database you are using.
4 Starting Diagnostic Suite
The Diagnostic Suite can be run in the following 3 ways:

1) From Noah
2) From OtoAccess™
3) Standalone (without a database)

4.1 Start from Noah
From Noah activate the Module Selection dialog and select the new Diagnostic Suite icon (below, right side):
4.2 Start from OtoAccess™
From OtoAccess™ select the new Diagnostic Suite icon from the “Select Instrument” group box in the top right side:

4.3 Start as Standalone
The Diagnostic Suite application may also be run in a standalone mode, without the use of database. In this case the Suite will not handle a patient, only a list of sessions stored in a XML file located under:

\Documents and Settings\All Users\Application Data\Interacoustics\Diagnostic Suite\Data\Standalone.xml
5 Audiometry Data Transfer

The first section describes how to transfer audiometric data from the instruments that do not support on-line/PC-operated mode: AS608e, AD226, AD229b/e, AC33, AC40. AD629 supports hybrid modes (on-line/PC-controlled modes) and patient/session transfer which is described in the next chapter.

5.1 Instrument Setup

The instrument setup is done in the Diagnostic Suite under Menu | Setup | General setup under the Instrument Setup section:

Select from the Instrument drop down menu to which instrument you are connected. Then select from the Comport drop down menu through which comport the instrument connects to your pc. Note that although your instrument might be connected through a USB connection, you still need to select through which comport that USB connection is supported. To find the appropriate comport, right click on My Computer (on your desktop or in Windows Explorer) and select “Manage”. Click on “Device Manager” and find the comport number where it says “USB Serial Port”. In general the lowest available comport mentioned here is used.

Press OK to save your settings and close the General Setup window.
Press **Help** for further instructions on how to find the appropriate comport and also for the instruments which are connected through an UCA40 to find the appropriate setup. Below the help windows are shown.

**Help, communication setup**

1. Make sure to adjust the switches on the UCA40 according to the table below.

**IMPORTANT:** When the switches has been adjusted, please disconnect the UCA40 from the PC and reconnect. The changes will not take effect until this has been done!

2. Please adjust the communication settings on the connected instrument according to the table below:

<table>
<thead>
<tr>
<th>Instrument</th>
<th>DIP1</th>
<th>DIP2</th>
<th>DTR Pulse/ Handshake</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS216</td>
<td>Off</td>
<td>Off</td>
<td>Set-up item 12=off</td>
</tr>
<tr>
<td>AD26</td>
<td>Off</td>
<td>Off</td>
<td>Set-up item 2=off</td>
</tr>
<tr>
<td>AD226</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AD229 b/e</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>SAM15</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>SAM16</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>T5</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>T9</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AA50</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AC40</td>
<td>Off</td>
<td>Off</td>
<td>No verification</td>
</tr>
<tr>
<td>MT10</td>
<td>On</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>MT110</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>MTP10</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>AZ26</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>AT235(h)</td>
<td>On</td>
<td>Off</td>
<td>N.A.</td>
</tr>
<tr>
<td>AA220</td>
<td>Off</td>
<td>Off</td>
<td>N.A.</td>
</tr>
<tr>
<td>AA222</td>
<td>On</td>
<td>Off</td>
<td>N.A.</td>
</tr>
<tr>
<td>MS25</td>
<td>Off</td>
<td>Off</td>
<td>No</td>
</tr>
<tr>
<td>MS40</td>
<td>Off</td>
<td>On</td>
<td>No</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Please set baud rates to 38400 for all instruments.
3. Right-click on "My Computer" and select "Manage".

4. Click on "Device Manager" and find the comport number where it says "USB Serial Interface". That is the comport to select.
5.2 Quick Start - Transferring Measurement Data

When the instrument setup is done the Diagnostic Suite is ready for retrieving the audiogram data from the selected instrument. The Diagnostic Suite main display looks like this:

![Diagnostic Suite Main Display](image)

Diagnostic Suite is a modified version of the AC440 module, originally designed to be executed on the Affinity and Equinox platforms.

The DS application version 1.00 is for transferring data from the dedicated instruments only. The top display is disabled.

On the above screenshot the Diagnostic Suite is setup to work with an AD229 as indicated by the small instrument icon in the left side of the display. If the instrument is not connected the following place holder icon is displayed:

![Placeholder Icon](image)
When the measurement is completed on the selected instrumented press the following icon to transfer the data:

Audiometric data transferred from audiometer and displayed in the Diagnostic Suite module. The below screen shot shows the L/R audiograms transferred from the AD229 audiometer:
Important Note: The Diagnostic Suite only allows viewing, storing and printing data.

Important Note: If the instrument is disconnected the following dialog is displayed when pressing the transfer button:

Device cannot be found. Please check power, UCA40 settings and cable connection.

Please turn OFF and ON the instrument.

Speech data is transferred in a similar way:
5.3 Main Functions and Features

Menu: This dropdown gives the clinician access to various tests, module settings, and functionalities.

Print: With this button the clinician can print out of the sessions acquired data.

Save & New Session: This button saves the current session in Noah or OtoAccess™ and opens a new one.

Save & Exit: This button saves the current session in Noah or OtoAccess™ and exits the Diagnostic Suite module.

Enable Talk Forward: This feature is not supported in this version of the Diagnostic suite.

Go to Tone Audiometry: This button activates the tone audiogram screen which enables the clinician to toggle between Tone and Speech testing.

Go to Speech Audiometry: This button activates speech audiogram screen which enables the clinician to toggle between Tone and Speech testing.

Extended Range +20 dB: This feature is not supported in this version of the Diagnostic suite.

List of Defined Protocols: This feature is not supported in this version of the Diagnostic suite.

Temporary Setup: This feature is not supported in this version of the Diagnostic suite.

List of historical sessions: This dropdown offers direct access to view historical sessions – e.g. for comparison purposes.

Go to Current Session: This button brings the Session List back to Actual Session when having looked at historical curves.

Toggle between Lock and Unlock the Selected Session: This button freezes the actual or historical session on the screen for comparison to other sessions.
**Show High Frequencies:** With this button active frequencies up to 20 kHz are shown on the audiogram.

**High Frequency Zoom Test Mode:** This feature is not supported in this version of the Diagnostic suite.

**Toggle between Single and Dual Audiogram Mode:** This button allows the clinician to toggle between viewing the audiogram as one or two graphs.

**Multi Frequency:** This feature is not supported in this version of the Diagnostic suite

**Synchrony:** This feature is not supported in this version of the Diagnostic suite.

**Report Editor:** This button opens the report page that allows the clinician to save and print journal entries and setup templates for commonly used words or phrases e.g. diagnoses.
**Edit Mode:** This feature is not supported in this version of the Diagnostic suite.

**Enter Mouse Operated Test Mode:** This feature is not supported in this version of the Diagnostic suite.
5.4 The Diagnostic Suite Audiometry Menu Items
The Diagnostic Suite Menu gives the clinician access to several options the majority of which is found under Menu in the top left part of the screen.

5.4.1 Print
The Print menu is entered by clicking Menu followed by Print as illustrated below:
1) Clicking Print will prompt the system to print using the selected print template.

2) Selecting Print Preview will allow the clinician to see a preview of the print sheet before printing as illustrated below. This is, however, only the case if a Print Template has been selected for the test setup being used. If a Print Template has not been selected the Print Wizard will open.

3) Choosing Print Wizard gives the clinician the option to create an individual customized print sheet.

5.4.2 Edit
The Edit menu is entered by clicking Menu followed by Edit as illustrated below:
Selecting Transfer to current session will move a currently viewed historical curve to the current session. Find the preferred historical session in the List of historical sessions dropdown in the front screen.

1) Choosing Export will prompt the system to export the session as an XML formatted file.
5.4.3 View
The View menu is entered by clicking Menu followed by View as illustrated below.

1) Selecting **Save window position** will save the current position of the Diagnostic Suite window on the PC screen so that it will open at this exact position every time. This is for example practical if the clinician usually runs and views other software modules at the same time. Using this function moving and/or resizing of the Diagnostic Suite will only be necessary once.

5.4.4 Tests
The Tests menu is entered by clicking Menu. Here the different tests can be chosen when ready to be used.

1) Selecting **Tone** will open the Tone Screen
2) Selecting **Speech** will open the Speech Screen

5.4.5 Setup
The Setup menu is entered by clicking Menu followed by Setup as illustrated below. Here the different Setup menus can be chosen.

1) Selecting **AUD setup** will open the Main Setup.
2) Selecting **General Setup** will open the General Setup.
3) If the system is pass word protected selecting **Change password** allows for changing or deleting the pass word valid for the Diagnostic Suite Suite
4) **Language** selection allows for selecting the preferred language.
5.5 Main Setup
The Main Setup is found under Menu | Setup | AUD Setup:

This version of the Diagnostic Suite does not support PC-controlled mode and therefore the Protocols section is disabled.

5.5.1 General Tab Page
The first General tab page contains the following Tone setting sections:

1) **Masking**: The clinician also has the possibility to tick **Show masking information on screen** if the masking intensity for every threshold is to be visible on the screen below the audiogram. The clinician may choose to see the masking information for air conduction (AC), bone conduction (BC), free field (FF) and insert phones (IP).

2) **Single Diagram**: Show both channels in one diagram.

3) **Speech**: Choose between table and graph speech display mode.
5.5.2 Tone Audiometry Tab Page

The second Tone audiometry tab page is displayed in the following:

4) Using the options under the Tone audiometry tap the clinician can select the desired test frequencies for HL/MCL and UCL by ticking the preferred frequencies. This way only the selected frequencies will appear on the audiogram.

5) The Hearing loss index on audiogram allows for ticking Show European CPT-AMA index or Show PTA (Fletcher) index. The European CPT-AMA is calculated using the numbers from the table below which ensures that the different frequencies are weighted correctly. If selecting the PTA (Fletcher) index the clinician can choose the thresholds that should be included in the calculation. Otherwise these will be grayed out. The default setting will be 500, 1000, 2000, and 4000 Hz.
5.6 General Setup

The **General Setup** is found under **Menu | Setup | General setup**:

1) Start by selecting the preferred group of symbols in the dropdown under **Symbol scheme**. Choose between Australian Standard, German, International, and US Symbols. …

2) If a group of symbols is not desired to be on the list, mark them in the dropdown and click **Delete**.

3) The clinician can make adjustments to existing symbols by marking them in the dropdown and click **Edit**. This will prompt the screen below. Note that this dialogue has three tabs enabling the clinician to correct symbols for **Tone and Speech**, **Weber**, and **MLD**.

4) 5 6 7 8 9

---

**Operation Manual**

**Diagnostic Suite**

21
**Tone and Speech** symbols can be edited in the first tab. Select the specific symbol to edit by specifying its properties using dropdowns and checkboxes in the right side of the dialog.

4) In the white section next to the dropdowns the clinician can design the desired symbol. Left click with the mouse in the small squares to colour them. To delete the colour in one of the squares right click on it. **Colour, Line type and Line thickness** can be set using the three dropdowns to the left.

5) The small square in the upper right corner allows for a preview of how the symbol will appear on screen.

6) Correcting symbols for **Weber** and **MLD** are done following the same procedure as described above only with fewer options as illustrated below.

7) If the symbols preferred by the individual clinician is not found in the list, the Diagnostic Suite contains the possibility to create own symbols from scratch. To create a new symbol click **New**. The following screen will then appear allowing the clinician to name and **Save** the symbol scheme.

8) The name chosen will then appear in the **Symbol scheme** dropdown.

9) The instrument setup is done in the Diagnostic Suite under **Menu | Setup | General setup** under the “Instrument Setup” section. Choose one of the supported instruments and select a COM port (1-2). Only the AS608e uses USB at the moment. Press “OK” to apply the settings. No the Diagnostic Suite is ready for retrieving the audiogram data from the selected instrument.
6 Diagnostic Suite with AD629
This section describes the data-transfer and hybrid mode (On-Line / PC-operated modes) supported by the new AD629 (applies to both b and e versions).

6.1 Instrument Setup
The setup is similar to that described in the previous chapter for audiometric data transfer.

A logo for direct print outs can be transferred to the AD629 using the “Up Print Logo” button. The symbol scheme used in the Diagnostic Suite can be transferred to the AD629 (when viewing the build in audiogram) by using the “Upload Custom Symbols” button. Please refer to the AD629 operational manual for info on how to change the symbol scheme on the AD629.

6.2 License Options
When running AD629 with Diagnostic Suite it can work in different ways depending on the license on the AD629:
- **The basic (sync) license** only allows patient upload (from Noah or OtoAccess™) and session data download (from internal AD629 memory) to either Noah, OtoAccess™ or XML (when running Diagnostic suite without a database). It's also possible to connect USB PC-keyboard for easy and fast client entry.

- **The Hybrid mode (On-line mode / PC-Controlled mode) license** allows for two-way PC-control:
  - Control the Diagnostic Suite PC-software from the AD629 keyboard (and store data direct on the PC side in Noah, OtoAccess or XML) directly.
  - Use AD629 as a PC-based back-box by controlling using the Diagnostic Suite software directly by the PC-keyboard and mouse.

On-line mode and PC-operated mode (= Hybrid mode) can work fully synchronously – i.e. at the same time. When connecting the AD629 with the Diagnostic suite, the build in screen on AD629 will just display the following text: “Online and PC Controlled Mode”.

### 6.3 SYNC Mode (Patient/Session Transfer)

The screen shot below shows the Diagnostic Suite with the SYNC tab open (underneath the AUD and IMP tabs in the upper right corner).

The SYNC tab provides the following possibilities:
**Client upload** is used for uploading clients from the database (Noah or OtoAccess) to the AD629. The internal AD629 memory can hold up to 500 clients and 50,000 sessions (audiogram data).

**Session download** is used to download sessions (audiogram data) stored in the AD629 memory into Noah, OtoAccess or XML (when running Diagnostic suite without a database).

### 6.3.1 Client Upload

The following screen shot shows the client upload screen:

- On the left side it’s possible to search for the client in the database to transfer to the database using different search criteria’s. Use the “Add” button to transfer (upload) the client from the database to the internal AD629 memory. The internal AD629 memory can hold up to 500 clients and 50,000 sessions (audiogram data).

- On the right side the clients currently stored on the internal AD629 memory (hardware) is down. It’s possible to remove all clients for individual clients using the “Remove all” or “Remove” buttons.
6.3.2 Session Download

The following screen shot shows the session download screen:

When pressing the icon the functionality of the “Session download” screen is described:

<table>
<thead>
<tr>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match (Transfer)</td>
<td>This client on AD629 was found (matched) in the database and the measurement will be transferred (downloaded) into the database after pressing 'Transfer to database'.</td>
</tr>
<tr>
<td>No match (Skip)</td>
<td>This client on AD629 was not found (not matched) in the database and the measurement will not be transferred (downloaded) into the database after pressing 'Transfer to database'.</td>
</tr>
<tr>
<td>Download complete</td>
<td>The client measurement data stored on AD629 was successfully transferred (downloaded) to the selected client in the database.</td>
</tr>
</tbody>
</table>

A client on the AD629 can be transferred (downloaded) into a different (existing or new) client in the database by selecting "Change" under the "Action" column. This will open a new dialog for changing the client selection.
6.3.3 One Click Data Transfer (latest saved session)
When in the AUD (audiometry) tab it's possible to transfer the latest saved session from the default client named “Standalone” on the AD629 using the following icon:

![Diagnoistic Suite](image)
6.4 Hybrid (Online/PC-Controlled) Mode
The following screen shots show the Diagnostic Suite AUD tab when running AD629 in “hybrid mode”.

This mode allows for the AD629 to be “on-line” connected to the PC – please refer to the “License options” section above for a further explanation. Section 9 explains in detail how the AUD module works when running it in hybrid mode.
The settings of the Diagnostic Suite AUD module can be modified under the AC440 setup:

The AC440 setup screen for AD629 is displayed in the following:
7 Tympanometry Data

7.1 Instrument Setup

The connection your Tympanometer needs to be setup through the General Settings of the IMP tab. Open the General Settings window by pressing IMP | Menu | General Settings.

Select from the Instrument drop down menu to which instrument you are connected. Then select from the Comport drop down menu through which comport the instrument connects to your pc. Note that although your instrument might be connected through a USB connection, you still need to select through which comport that USB connection is supported. To find the appropriate comport, right click on My Computer (on your desktop or in Windows Explorer) and select “Manage”. Click on “Device Manager” and find the comport number where it says “USB Serial Port”. In general the lowest available comport mentioned here is used.

Press OK to save your settings and close the General Setup window.

Press Help for further instructions on how to find the appropriate comport and also for the instruments which are connected through an UCA40 to find the appropriate setup. Below the help windows are shown.

Checking the option Display reflexes as negative will plot acoustic reflexes into the negative direction for all types of reflex measurements.
1. Make sure to adjust the switches on the UCA10 according to the table below.

**IMPORTANT:**
When the switches has been adjusted, please disconnect the UCA10 from the PC and reconnect. The changes will not take effect until this has been done!

2. Please adjust the communication settings on the connected instrument according to the table below.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>DIP1</th>
<th>DIP2</th>
<th>DTR Pulse/Handshake</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS21B</td>
<td>Off</td>
<td>Off</td>
<td>Set-up item 12=off</td>
</tr>
<tr>
<td>AD28</td>
<td>Off</td>
<td>Off</td>
<td>Set-up item 2=off</td>
</tr>
<tr>
<td>AD226</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AD229 b/e</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>SAM6</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>SAM6</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>T5</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>T9</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AA40</td>
<td>Off</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>AC40</td>
<td>Off</td>
<td>Off</td>
<td>No verification</td>
</tr>
<tr>
<td>MT10</td>
<td>On</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>MT110</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>MTP10</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>AZ28</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>AT235(h)</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>AA220</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>AA222</td>
<td>Off</td>
<td>On</td>
<td>N.A.</td>
</tr>
<tr>
<td>MS25</td>
<td>Off</td>
<td>Off</td>
<td>No</td>
</tr>
<tr>
<td>MS40</td>
<td>Off</td>
<td>On</td>
<td>No</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Please set baud rate to 38400 for all instruments.
3. Right-click on "My Computer" and select "Manage".

4. Click on "Device Manager" and find the comport number where it says "USB Serial Interface". That is the comport to select.
7.2 Quick Start – Transferring and Saving Tympanometry Data

Note that the Diagnostic Suite does not allow you to measure data controlled by the pc. Diagnostic Suite allows you to transfer data, view data, add a report and save your data and report and/or print it with a customized print template.

To transfer tympanometry data you need to be in the IMP tab. At startup it will show empty graphs like below.

Press the arrow icon, , in order to transfer data from your equipment to your pc.

When the equipment is not yet connected or switched on or if the instrument setup is incorrect, a message will inform you to check the communication port.
Press the report icon, \( \mathbb{F} \), in order to open the report editor and add notes to the transferred data.

Press the print icon, \( \mathbb{P} \), in order to open the print wizard from which you can select according to which template to print.

Press the save icon, \( \mathbb{S} \), to save or the save and exit icon, \( \mathbb{E} \), to save and exit.
7.3 Main Functions and Features

Menu: This dropdown gives the clinician access to various tests, module settings, and functionalities.

Print: With this button the clinician can print out of the sessions acquired data.

Save & New Session: This button saves the current session in Noah or OtoAccess™ and clears all data to create a new session.

Save & Exit: This button saves the current session in Noah or OtoAccess™ and exits the Diagnostic Suite module.

Change ear: Pressing this icon will change to the other ear.

List of Defined Protocols: This feature is not supported in this version of the Diagnostic suite.

Temporary Setup: This feature is not supported in this version of the Diagnostic suite.

List of historical sessions: This dropdown offers direct access to view historical sessions – e.g. for comparison purposes.

Go to Current Session: This button brings the Session List back to Actual Session when having looked at historical curves.

Transfer data: Pressing this button will import data for both ears from the equipment to the Diagnostic Suite.

Report Editor: This button opens the report page that allows the clinician to save and print journal entries and setup templates for commonly used words or phrases e.g. diagnoses.

![Report Editor](image.png)
List of transferred tests: The listing shows for which tests data was transferred. A checkmark indicates that data for that test is available. A missing checkmark indicates that data must be present for the other ear. The data from the highlighted test is shown in the viewing panel.
7.4 The Diagnostic Suite Tympanometry Menu Items

7.4.1 Print
IMP | Menu | Print | Print Wizard opens the Print Wizard. In the print wizard you can select a template for printing or preview the available measurements. The Print Wizard also allows creating and/or modifying print templates. This is further described in chapter 8.

7.4.2 Edit
Selecting IMP | Menu | Edit | Export… allows you to save the current data as a separate xml file. The data can then be used or analysed by other software.

7.4.3 Setup
IMP | Menu | Setup | General Settings opens the general settings window in which the connection to your instrument is configured and also in which you choose if reflexes are plotted into positive or negative direction.

IMP | Menu | Setup | Report setup… opens the Report Editor which allows you to enter notes which are saved with the session. The Report Editor is described in chapter 8.

IMP | Menu | Setup | Language allows selecting the preferred language.

7.4.4 Help
Selecting IMP | Menu | Help | About… will show a popup with the software version of the Diagnostic Suite.
8 Reports and Printouts
The Diagnostic Suite also includes the possibility to create individual report pages and printouts. This way the clinician can keep all data electronically and if printouts are needed these can be customized according to the needs of the individual clinician.

8.1 The Print Wizard
The clinician also has the option to create customized print templates for printouts. This is done in the **Print Wizard** which is entered by clicking **Menu | Print | Print Wizard**.
8.2 Getting Started

1) When the Print Wizard is open the clinician is able to choose between different print layout templates. The Diagnostic Suite both includes Factory defaults and customized User defined layouts.

2) The Factory defaults ensure that the clinician always has a standard printout and does not need to create a customized one. However, these cannot be edited according to personal preferences as indicated by the yellow lock on the screen shot below. User defined layouts are the clinicians own personal layouts. These can be created according to individual needs preferences of each clinician.

3) To view both Factory defaults and User defined layouts before printing, mark the desired template by clicking on it followed by selecting Preview in the left corner of the dialogue.

4) To print using a specific layout, mark the desired template by clicking on it followed by selecting Print. The data from the current session will then be printed using the preferred layout.

5) To leave the Print Wizard without selecting or changing a printout click Cancel.
8.3 Designing an Individual Printout

1) To create an individual customized print layout click on New template in the upper right corner of the Print Wizard. This will prompt the screen below. The dialog in the middle of the screen explains the basic in making a customized template. When having read the instructions Show hints may be unchecked and the message will not be shown again.

2) Elements can be selected from the list to the left and dragged or placed onto the white piece of paper that represents the print sheet. Start by selecting the preferred General elements such as for example Client information. Click on it, drag it onto the blank print sheet, and drop it. The Client information will then appear as a small box in the upper left corner. Enlarge it in size by pulling the elements adorners with the mouse and move it to the desired position on the print sheet.

3) To enter or edit Client information right click on it which will prompt a box with more options. Clicking on Select fields will give the clinician the option to choose which patient data should be included in the list, such as first name, last name and birth date. Format will prompt a dialogue allowing the clinician to change text characteristics such as font and size. Choosing Rotate will rotate the text box clockwise 90 degrees at the time.

4) The clinic logo may also be imported into the layout if the file is saved on the PC or USB. This is done by clicking on Logo, dragging it onto the blank print sheet, and dropping it. And empty box will then appear as a small box in the upper left corner.
Enlarge it in size by pulling the elements adorners with the mouse and move it to the desired position on the print sheet. Right click on it and choose Select image to browse for the logo on the PC or USB. Selecting Rotate will rotate the logo clockwise 90 degrees at the time.

5) If a certain text is to be viewed on the print sheet such as the name of the clinician the may also be added. Click on Text, drag it onto the blank print sheet, and drop it. A text box will then appear as a small box in the upper left corner. Enlarge it in size by pulling the elements adorners with the mouse and move it to the desired position on the print sheet. Right clicking will prompt a dialog allowing the clinician to write the preferred text in the desired format. Selecting Rotate will rotate the text box clockwise 90 degrees at the time.

6) The template can contain elements from all three measurement modules, REM, AUD, HIT and IMP. When having added the desired general elements select a module in the lower left side of the screen to view the available elements for each of them.

7) To add for example the audiogram, select AUD. The Diagnostic Suite selections will then be available in the left side of the screen.

8) Select Audiogram and drag it onto the layout sheet. The graph will then appear as a small box in the upper left corner. Enlarge it in size by pulling the elements adorners with the mouse and move it to the desired position on the print sheet.

9) To make changes to an element on the layout (such as for example the Audiogram) right click on it which will prompt a box with more options. Clicking on Select type will give the clinician access to the Set graph type dialogue shown above. Here it is possible tick whether the high frequencies should be in the audiogram, if a masking table should be visible, or if the audiogram should show one or both ears.
Selecting *Toggle border* will show or hide the border of the element. Choosing *Rotate* will rotate the graph clockwise 90 degrees at the time.
8.4 Formatting a Print Layout

When having added and adjusted the desired elements from some or all the modules the clinician may want to format the customized print layout to achieve an even more graphically attractive and professional looking print layout, This is done using the top tool bar shown below:

1) The **Add page** button adds additional pages to the template. This way the clinician can split up the layout in multiple pages allowing for more elements to be added or for the graphs and tables to be bigger.

2) The **Remove page** button deletes the active page from the template. The clinician will be prompted if certain about deleting the page and old its contents.

**Note:** If only one page is used make sure that only 1 of 1 page is displayed if that is what is desired, otherwise an extra page will commence printing for every print job. Use the **Remove Page** button to delete unwanted pages. The two arrow buttons in the bottom of the screen can be used to scroll up and down in the print layout and thereby get a better overview.

3) The **Align left** button allows the clinician to align elements to the left. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their left sides.

4) The **Align right** button allows the clinician to align elements to the right. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their right sides.

5) The **Align top** button allows the clinician to align elements to the top. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their upper sides.
6) The **Align bottom** button allows the clinician to align elements to the bottom. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their lower sides.

7) The **Align Horizontal** button allows the clinician to align elements to their horizontal central axis. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their horizontal central axis.

8) The **Align Vertical** button allows the clinician to align elements to their vertical central axis. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be aligned on their vertical central axis.

9) The **Make equal size** button allows the clinician to make elements the same size. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be equal in size to the element which was firstly placed on the page.

10) The **Same width** button allows the clinician to make elements the same width. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be equal in width to the element which was firstly placed on the page.

11) The **Same height** button allows the clinician to make elements the same height. Select two or more elements (using the shift button on the keyboard) and click the button. The selected elements will then be equal in height to the element which was firstly placed on the page.

12) The **Send to back** button allows the clinician to send the selected element(s) to the back.

13) The **Send to front** button allows the clinician to send the selected element(s) to the front.

14) The **Lock element** button locks (or unlocks) the selected element(s) if the clinician wishes to (un)lock an element in a fixed position and size on the print layout. Select one or more elements (using the shift button on the keyboard) and click the button. When one of the taskbar functions is used on a locked element it will automatically unlock.

15) The **Display margins** button toggles between showing and not showing the print margins as a dashed line. This helps the clinician not to place elements outside the print margins.
16) When finished with the print layout click **Save** or **Save As** to leave the *Print Wizard*. After naming the layout it will be selectable from the *Print Wizard* dialogue.

17) In the upper right corner the clinician may select **Page Setup**. This will prompt the dialogue above allowing the clinician to set general settings such as *Paper*, *Orientation* and *Margins*.

---

### 8.5 Making Reports

The Diagnostic Suite allows for doing reports electronically through the *Report editor*. This way reports are saved in the module for each session and can be retrieved at any time. The reports can also be implemented in the personal printout which gives the clinician the opportunity to have all the relevant test information (e.g. curves and comments) in one customized piece of paper. The report function also includes the possibility to make report templates which for example gives the clinician the option to have different templates for different client groups. This is helpful as clinicians are most likely to have different procedures when having to deal with for example adult and children. The option to make several templates is also useful if the Diagnostic Suite is used by more than one clinician. Each individual is then able to create personal templates for their own use.

### 8.6 Getting Started

The *Report editor* contains key elements from Microsoft Word which makes it familiar and user friendly.
1) The *Report editor* is entered by pressing the button in the front screen. This will open the dialogue below:

![Diagram of report editor](image)

2) If templates are not preferred the clinician can immediately start writing comments in the white section. The tool bar can be used to make graphical changes.

3) Change the **Font** and **Size** in the two dropdowns for this purpose.

4) If parts of the text are preferred to be in **Bold**, **Italic**, or **Underlined**, mark it with the curser and click the corresponding buttons.

5) If parts of the text are desired to have another **Font Colour** or to have a **Back Colour**, mark it and use the colour selection provided by the two buttons.

6) The **Image** icon will prompt the dialogue below to be used to import a picture into the report (for example the patient’s picture). Click **Browse** and find the picture at its location on the PC or USB.
The clinician also has the possibility to write an *Alternate Text* and determining the picture *Layout* and *Spacing*.

7) The four justify buttons provides the option to **Justify Left**, **Justify Center**, **Justify Right**, or **Justify Full** depending on the preference of the clinician. This is done by marking the text with cursor and choosing one of the buttons.

8) An **Ordered list** (prioritized using numbers) or an **Unordered list** (made with bullet points) may also be needed. Mark the part of the text to be listed with the cursor and click on the desired button.

9) The **Outdent** and **Indent** buttons ensures correct placement on the report page. Mark the part of the text to be moved with the cursor and click the desired button.
8.7 Creating a Report Template

To create a customized template, click on File in the upper left corner followed by New Template. This will prompt the dialogue shown below:

1) Write the desired name of the new template under Template Name and click OK

2) The new template dialogue will then disappear and the selected name will appear the Insert Template dropdown and as a head line for the Report editor dialogue.

3) Write the desired content of the template (e.g. the example above). Use the toolbar to change for example Font and Size.

4) When satisfied with the template click Save in the upper left corner and the template will be ready for use and selectable from the Insert Template dropdown.
8.8 Menu Items

The Menu Items offers additional options consistent with the choices found in Microsoft Word and may be of assistance during the reporting making changes and adjustments.

8.8.1 The File Menu

Open the File Menu by clicking on it in the upper left corner.

1) If the clinician is currently browsing through previous obtained reports the system will return to the current report session upon selection Switch to Current Report.

2) Selecting Save Report will save the current report.

3) If the whole report text is to be deleted and/or redone select Clear Report.

4) Selection New Template will allow the clinician to create a new template.

5) If another template is to be selected for the current report, select Open Template which will open the dialogue below. Click on the preferred template under Existing Templates followed by OK.
6) If being in the process of creating a new template this may be saved by selecting **Save Template**.

7) If the clinician wishes to delete the template currently in use select **Delete Template**.

8) The clinician has the option to import a template by selecting **Import Template**. Browse for the template on the PC or USB and click **Open**.

9) If selected template is preferred to be the default template (automatically chosen when the *Report editor* is opened), select **Set as Default Template**.

10) Selecting **Insert Template** will allow the clinician to select a new template for the current report.

11) The clinician has the option to export a report template by selecting **Export**. Browse for the location where the test is to be situated, and click **Save**.

12) To print out the report select **Print**.

13) To close the *Report editor* click **Exit**.

### 8.8.2 The Edit Menu

Open the *Edit Menu* by clicking on it in the upper left corner.

1) Here the clinician will find functions such as **Undo/Redo** in case mistakes are made during the report writing.
2) **Copy, Cut,** and **Paste** can also be selected which may assist in moving parts of the text.

3) The clinician can use **Select All** if changes are made for the whole report.

4) If looking for a specific word or sentence in the text **Find** may be useful to browse for it.

The Report editor uses html as basis. In order to modify certain aspects of text, tables and images **Edit HTML** may be selected.

### 8.8.3 The Insert Menu

Open the **Insert Menu** by clicking on it in the upper left corner.

1) **Picture** contains the same function as the Image icon.

2) Selecting **Break** will insert a horizontal line into the report.
8.9 Importing and Exporting a Report Template

The *Report editor* also allows the clinician to export and import report templates. In other words, this means that the clinician can save a particular template and export it to other computers and/or import a test exported and saved on for example a USB memory stick by another clinician in possession of the Diagnostic Suite.

8.9.1 Importing a Report Template

1) Enter the File menu and select **Import Template**.

2) Browse for the report file and find it at its location on the PC or USB. Click **Open**.

3) The template will then be selectable in the **Insert Template** dropdown.

---

8.9.2 Exporting a Report Template

1) Enter the File menu and select **Export**.

2) Find the location where the report file is to be located and click **Save**. Other people in possession of a Diagnostic Suite will then be able to upload the file using the **Import Template** function.
9 The AD629 Audiometry Module in Hybrid Mode
The following chapter describes the Diagnostic Suite Audiometry module (AC440) when using the AD629 hybrid (online/PC-controlled) mode.

9.1 AC440 Tests

The AC440 contains the following tests/counseling tools:
- Air conduction audiometry
- Bone conduction audiometry including Weber
- Free field audiometry
- Speech audiometry
- Masking

9.1.1 Air Conduction Audiometry
In air conduction audiometry a test signal is presented to the test subject by headphones (and/or inserts phones). The test subject responds to the signal by pressing a client response button. The audiometric threshold is defined as the lowest intensity at which the client is able to detect the test signal 50% of the time.

The purpose of air-conduction audiometry is to establish the hearing sensitivity at various frequencies. The test provides information about the conductive and sensory systems of hearing but cannot distinguish between abnormality in the conductive mechanism and sensor neural mechanism.

9.1.1.1 High Frequency Audiometry
High frequency audiometry (8 kHz – 20 kHz) is performed using the same procedure as normal air conduction audiometry. It is helpful when having to test hearing impairments caused by ototoxicity, noise exposure, and acoustic traumas as these mainly affect the high frequencies. This frequency area is more susceptible to the effects of external factors such as medications and loud noises than the low and middle frequencies.

9.1.2 Bone Conduction Audiometry
In bone-conduction audiometry, the test signal is presented by a bone vibrator placed on the mastoid of the test subject. It is recommended to start hearing threshold level determinations with air-conduction measurements followed by bone-conduction measurements.

The bone vibrator uses the skull to transfer the vibrations to the cochlear and bypasses the outer and middle ear. Bone conduction thresholds thereby provide a measure of the cochlear and retro cochlear function regardless of the outer and middle ear function. The difference which is detected between the bone and air conduction is called the air-bone gap.
9.1.3 Free Field Audiometry

Free field audiometry is a behavioral audiometric test obtained in a sound-treated room. This may for example, be helpful when the client is either unwilling or unable to wear headphones, such as small children, or is uncooperative during a traditional audiometry test. Through two calibrated loudspeakers sounds are presented to the client. In visual reinforcement audiometry, the infant’s eye-shift or head-turn response to the sound source is rewarded by activating a lighted mechanical toy or picture on a screen near the loudspeaker. The purpose of free field audiometry is to establish the hearing sensitivity at various frequencies. But note that free field testing gives an audiogram for the better-hearing ear if any ear difference in hearing is suspected. Free field audiometry is also used for testing with hearing aids.

9.1.4 Speech Audiometry

Most people acquire hearing aids because they or their relatives report that they have trouble hearing speech. Speech audiometry has the advantage of utilizing speech signals and is used to quantify the client’s ability to understand everyday communication. It examines the processing ability and can be helpful to investigate whether the processing is affected by disorders of the middle ear, cochlear, auditory nerve, brain stem pathway, or auditory centers of the cortex. Speech audiometry can be performed using a number of tests. For example, SRT (Speech Recognition Threshold) refers to the level at which the client can repeat 50% of the presented words correctly. It serves as a check of the pure tone audiogram, gives an index of hearing sensitivity for speech and helps determining the starting point for other suprathreshold measures such as WR (Word Recognition). WR is sometimes also referred to as SDS (Speech Discrimination Scores) and represents the number of words correctly repeated expressed as a percentage.

Note that there is a predictable relationship between the clients pure tone threshold and speech threshold. Speech audiometry may therefore be useful as a cross-check of the pure tone audiogram.

9.1.5 Masking

In cases where a symmetrical hearing loss is detected, traditional audiometry without masking is sufficient. However, the clinician should be aware that if this is not the case one cannot be certain that the intended ear is the one actually detecting the sound. When for example making an audiogram on a client with hearing within the normal range on one ear but a moderate to severe hearing loss on the other, there is a potential risk of the good ear hearing the tone when trying to test the damaged ear. That is, the sound vibration may travel through the head and be heard by the opposite good ear when the vibrations of the signal are of sufficient magnitude. Therefore, you are actually measuring the thresholds from the wrong ear.

To prevent this phenomenon in causing an erroneous measurement, masking noise can be used to occupy the good ear (non-test ear) while testing the other one (Stach 1998, Katz 2002 and British Society of Audiology 2004). Masking can be applied to air conduction, bone conduction and speech audiometry. The need to mask the better hearing ear is linked to the intraoral attenuation which equals the amount of attenuation the sound is exposed to on its way through the skull. Even though the intraoral attenuation is very individual and varies with frequency it can, on average be estimated to a minimum of 40 dB for supra-aural headphones and 50 dB for inserts. Regarding bone conduction, the intraoral attenuation is a minimum of 0 dB which means that crossover of the stimulus may occur all the time.
9.2 Using the Tone Screen

The following section describes the elements of the tone screen.

Menu: This dropdown list gives the clinician access to various tests, module settings, and functionalities (see section 0)

Print: With this button the clinician can print out of the sessions acquired data

Save & New Session: This button saves the current session in Noah or OtoAccess™ and opens a new one.

Save & New Session: This button saves the current session in Noah or OtoAccess™ and opens a new one.

Enable Talk Forward: This button will activate Talk Forward that enables the clinician to talk to the client through the talk forward microphone. Note that it is be possible to adjust the level of the signal.
Go to Tone Audiometry: This button activates the tone audiogram screen which enables the clinician to toggle between Tone and Speech testing.

Go to Speech Audiometry: This button activates speech audiogram screen which enables the clinician to toggle between Tone and Speech testing.

Extended Range +20 dB: This button extends the testing range and can be activated when the testing threshold reaches 50 dB below the maximum level of the headset. The shaded area in the graph illustrates the maximum intensity the system will allow. It is a reflection of the transducer calibration.

List of Defined Protocols: This dropdown list shows the test protocol used for a particular session. To select one of the pre-programmed protocols or one of your personally designed protocols (see section 9.4.1) by clicking the arrow on the right side.

Temporary Setup: This button opens a menu allowing the clinician to make temporary changes to the selected test protocol. Note that changes will be valid for the current session only. After making the changes and returning to the main screen, the name of the protocol will be followed by an asterisk (*). When a new setup is selected the * will disappear and the original settings will be active again.

List of historical sessions: This dropdown offers direct access to view historical sessions for comparison purposes (see section 0).

Go to Current Session: This button brings the Session List back to Actual Session when having looked at historical curves.

Toggle between Lock and Unlock the Selected Session: This button freezes the actual or historical session on the screen for comparison to other sessions (see section 0).

Show High Frequencies: With this button active frequencies up to 20 kHz are shown on the audiogram.

High Frequency Zoom Test Mode: With this button active the high frequencies can be tested.

Note that HF is an additional feature for the AC440. If not purchased the button is grayed out.

Toggle between Single and Dual Audiogram Mode: This button allows the clinician to toggle between viewing the audiogram as one combined graph or two separate ones.
**Synchronize**: This button will lock the Channel 1 attenuator to the Channel 2 attenuator.

**Report Editor**: This button opens the report page that allows the clinician to save and print journal entries and setup templates for commonly used words or phrases, for example, diagnoses.

![Report Editor](image)

- **Name**: Joan Jones
- **Date of Birth**: 1970/01/01
- **Diagnosis**: Otosclerosis
- **General Comments**: Hereditary disposition, pregnant with first baby
**Edit Mode:** This button activates the Edit Mode. Left clicking on the graph will add/move a point to the position of the cursor. If right clicking on a specific stored point a context menu appears offering the clinician the options shown below. Here it is possible to **Delete** the recorded points or the entire curve. Furthermore the Edit Mode provides the option to **Add No Response**, **Add Masked Threshold**, **Add Masked No Response Threshold**, or **Add Threshold Comment**. The clinician also has access to the **properties** of a stored point.

**Enter Mouse Operated Test Mode:** This button enables the clinician to do the audiometry using the mouse only. Frequency and intensity are changed with **mouse movements**, stimuli are presented with the **left mouse button**, and the threshold is stored with the **right mouse button**.

**Monitoring of Channel 1 or Channel 2:** The check boxes enable the clinician to monitor Channel 1 or Channel 2 or both Channels together through an external monitor loudspeaker or headset connected to the monitor input. The monitor intensity is adjusted with the slider.

**Talk Back:** If equipped with a microphone connected to the Talk Back input the clinician has the opportunity listen to the client through an external loudspeaker or headset connected to the monitor input. When the audiometer keyboard is connected the clinician can turn on and off Talk Back by holding down the right attenuator button for 1.5 second. Pressing and releasing the attenuator knob will toggle a mode were TB intensity can be adjusted with the attenuator knob.
HL, MCL & UCL: Here HL (Hearing Level) can be selected to do normal audiometry, MCL can be selected in order to test the Most Comfortable Levels, or UCL can be chosen to test the Uncomfortable Levels.

Output Channel 1: This dropdown list provides the option to select pure tone testing for both ears (Right and Left), bone conduction testing for both ears (Bone R and Bone L), free field testing (FF1 and FF2), and insert phone testing (Insert Right and Insert Left) as output for Channel 1.

Input Channel 1: The dropdown list provides the option to select Tone, Warble Tone, NB (Narrow Band Noise), and WN (White Noise) as input for Channel 1.

Presentation Channel 1: The clinician has the option to choose Man (manual) and thereby present the signal to the client only when the Stimuli Channel 1 is activated. Choosing Rev (reverse) will cause the signal to be presented continuously, only disappearing when the Stimuli Channel is activated.

Pulsation: The clinician has the option to select between single and continuous pulse presentation. The duration of the stimulus can be adjusted in the AC440 Setup (see section 9.4.3.1).

Output Channel 2: This dropdown list provides the option to select pure tone testing for both ears (Right and Left), masking using an insert phone (Insert Mask), free field testing (FF1 and FF2), and insert phone testing (Insert Right and Insert Left) as output for Channel 2. The Channel 2 can also be set to be Off if masking is unnecessary.

Input Channel 2: This dropdown list provides the option to select Tone, Warble tone, NB (Narrow Band noise), WN (White Noise) as input for Channel 2.

Note that TEN Noise is an additional feature for the AC440. If not purchased it is grayed out.
Presentation Channel 2: The clinician has the option to choose *Man* and thereby present the signal to the client only when the *Stimuli Channel 2* is activated. Choosing *Rev* will cause the signal to be presented continuously, only disappearing when the *Stimuli Channel 2* is activated.

Simultaneous/Alternate: The clinician has the option to select presentation in both channels *Sim* by locking Channel 1 and Channel 2 together or to have the presentation in the two channels alternating to each other *Alt*.

dB HL Decrease Channel 1: With the dB HL Decrease button the intensity in Channel 1 can be decreased with 1, 2, or 5 dB steps (depending on the test setup, see section 9.4.3) with a mouse click. This can also be obtained using the arrow down (or up if selected so in the setup) on the computer keyboard.

Stimuli Channel 1: When the mouse cursor is above the *Stimuli* area the tone will be presented. This can however also be obtained by pressing space bar or left Ctrl key on the computer keyboard. A left mouse click in the Stimuli area will store the threshold at the current position (clicking at another intensity at the same frequency will change the threshold to the new position). A right mouse click in the Stimuli area will store a no response threshold. Mouse movements in the Stimuli area can ignored depending on Setup (see section 9.4.3.1).

dB HL Increase Channel 1: With the dB HL Increase button the intensity in Channel 1 can be increased with 1, 2, or 5 dB steps (depending on the test setup, see section 9.4.3) with a mouse click. This can also be obtained using the arrow up (or down if selected so in the setup) on the computer keyboard.

Frequency and Intensity display area: On the left side of the black area the dB value for Channel 1 is shown and on the right side for Channel 2. In the middle of the black area the current frequency level is shown.
**dB HL Decrease Channel 2:** With the dB HL Decrease button the intensity and Channel 2 can be decreased with 1, 2, or 5 dB steps (depending on the test setup, see section 9.4.3) with a mouse click. This can however also be obtained using the arrow down (or up if selected so in the setup) on the computer keyboard.

**Stimuli Channel 2:** When the mouse cursor is above the Stimuli area the tone/noise will be presented. If Channel 2 is used for continuous masking noise, the noise will be muted when the mouse is over the Stimuli area or when right Ctrl key is pressed. Mouse movements in the area can be ignored depending on settings chosen in the setup (see section 9.4.3.1).

**dB HL Increase Channel 2:** With the dB HL Increase button the intensity in Channel 2 can be increased with 1, 2, or 5 dB steps (depending on the test setup, see section 9.4.3) with a mouse click. This can however also be obtained using the arrow up (or down if selected so in the setup) on the computer keyboard.

**Frequency increase/decrease:** When clicking on the Frequency buttons the frequency will be increased or decreased depending on the chosen direction. This can also be obtained using the arrow to the left or right on the computer keyboard.

**The graph:** The curves of the recorded tone audiogram will be displayed here.
9.3 Using the Speech Screen
The following section describes the elements of the speech screen:

**Go to Tone Audiometry:** This button activates the tone audiogram screen which enables the clinician to toggle between *Tone* and *Speech* testing.

**Go to Speech Audiometry:** This button activates speech audiogram screen which enables the clinician to toggle between *Tone* and *Speech* testing.

**Extended Range +20 dB:** This button extends the testing range and can be activated when the testing threshold reaches 70 dB below the maximum level of the headset. The shaded area in the graph illustrates the maximum intensity the system will allow. It is a reflection of the transducer calibration.
**List of Defined Protocols:** This dropdown list shows the test protocol used for a particular session. To select one of the pre-programmed protocols or one of your personally designed protocols (see section 9.4.1) by clicking on the arrow on the right side.

**Temporary Setup:** This button opens a menu allowing the clinician to make temporary changes to the selected test protocol. Note that changes will be valid for this session only. After making the changes and returning to the main screen, the name of the protocol will be followed by an asterisk (*). When a new setup is selected the * will disappear and the normal setup will be active again.

**List of historical sessions:** This dropdown list offers direct action to view historical sessions for comparison purposes (see section 00).

**Go to Current Session:** This button brings the Session List back to the Actual Session.

**Toggle between Lock and Unlock the Selected Session:** This button freezes the actual or historical session on the screen for comparison to other sessions (see section 0).

**Synchronize:** This button will lock the Channel 1 attenuator to the Channel 2 attenuator.

**Report Editor:** This button opens the report page that allows the clinician to save and print journal entries and setup templates for commonly used words or phrases for example, diagnoses (see section Error! Reference source not found.)
**Edit Mode:** This button activates the Edit Mode. Left clicking on the graph will add/move a point to the position of the cursor. If right clicking on a specific stored point the clinician will have the options shown below. Here it is possible to **Delete** the recorded thresholds or the entire curve. Furthermore Edit Mode provides the option to **Add No Response, Add Masked Threshold, Add Masked No Response Threshold,** or **Add Threshold Comment.** The clinician also has access to the **Properties** of a stored point.
**Input Levels:** Here the clinician is able to adjust the input level to 0 VU for the chosen input to obtain correct calibration and therefore a precise test (e.g. Mic1, Mic2, CD1, CD2). Mic1 and Mic2 can be adjusted when chosen as input. However, CD1 and CD2 are grayed out unless *Shift* is pressed on the PC keyboard. This ensures that no adjustments are made accidently.

**Monitoring of Channel 1 or Channel 2:** The check boxes enable the clinician to monitor Channel 1, Channel 2 or both Channels together through an external loudspeaker or headset connected to the monitor input.

**Talk back:** If equipped with a microphone connected to the talk back input the clinician has the opportunity listen to the client through an external loudspeaker or headset connected to the monitor input. When the audiometer key-board is connected the clinician can turn on and off Talk Back by holding down the right attenuator button for 1.5 second. Pressing and releasing the attenuator knob will toggle a mode were TB intensity can be adjusted with the attenuator knob.

**WR1, WR2, WR3:** In the AC440 Setup the clinician can setup the three default word lists. For example the clinician may prefer that when WR1 (*Word Recognition 1*) is marked then multi syllabic numbers are presented, when WR2 is marked then single syllabic words are presented and when WR3 is marked then multisyllabic words are presented. This makes it easy to toggle between the preferred speech materials (see section *Error! Reference source not found.*).

**MCL, UCL:** The clinician can choose to test MCL in order to test the *Most Comfortable Levels*, or UCL can be chosen to test the *Uncomfortable Levels*.

**Aided/Binaural:** The clinician can tick if the speech test is performed aided and/or binaurally.
Output Channel 1: This dropdown list provides the option to select speech testing output for both ears (Right and Left), bone conduction testing for both ears (Bone Right and Bone Left), free field testing (FF1 and FF2), and if using insert phones (Insert Right and Insert Left) as output for Channel 1.

Input Channel 1: The dropdown list provides the option to select microphone, CD player, wave files or speech noise (Mic1, Mic2, CD1, CD2, Wave file, SN) as input for Channel 1.

Pulsation: Here the clinician has the option to select between Single Pulse and Multi Pulse presentation. The duration of the stimulus can be adjusted in the AC440 Setup (see section Error! Reference source not found.)

Presentation Channel 1: Here the clinician has the option to choose Man (manual) and thereby present the signal to the client only when the stimuli/speech signal of Channel 1 is activated. Choosing Rev (reverse) will cause the signal to be presented continuously, only disappearing when the stimuli/speech signal of Channel 1 is activated.

Output Channel 2: This dropdown list provides the option to select speech testing output for both ears (Right and Left), Insert mask for masking via an insert phone, free field testing (FF1 and FF2), and if using insert phones (Insert Right and Insert Left) as output for Channel 1. This channel can also be set to Off if masking or binaural stimulation is not wanted.

Input Channel 2: The dropdown list provides the option to select Mic 1/Mic 2, CD1/CD2, WN (White Noise), SN (Speech Noise), and Wave files as input for Channel 2.

Presentation Channel 2: Here the clinician has the option to choose Man (manual) and thereby present the signal to the client only when the stimuli/speech signal of Channel 2 is activated. Choosing Rev (reverse) will cause the signal to be presented continuously, only disappearing when the Stimuli Channel 2 is activated.

Simultaneous/Alternate: Here the clinician has the option to select presentation in both channels Sim by locking Channel 1 and Channel 2 together or to have the presentation in the two channels alternating to each other Alt.
**dB HL Decrease Channel 1/Channel 2:** With the dB HL Decrease button the intensity in Channel 1 and 2 can be decreased with 1 or 5 dB (depending on the test setup) with a mouse click. This can however also be obtained using the left arrow button on the PC keyboard for Channel 1 and using PgDn on the PC keyboard for Channel 2.

**Stimuli Channel 1:** The area will light up when the speech stimulus is presented. If the speech stimulus is presented continuously the presentation can be interrupted by touching the Stimuli area with the mouse. Mouse movements in the area can be ignored depending on the Setup (see section Error! Reference source not found.).

**dB HL Increase Channel 1/Channel 2:** With the dB HL Increase button the intensity in Channel 1 and 2 can be increased with 1 or 5 dB steps (depending on the test setup) with a mouse click. This can however also be obtained using the right arrow button on the PC keyboard for Channel 1 and using PgUp on the PC keyboard for Channel 2.

a) **Correct:** A mouse click on this button will store the word as correctly repeated.

b) **Incorrect:** A mouse click on this button will store the word as incorrectly repeated.

c) **Store:** A mouse click on this button will store the speech threshold in the speech graph.

**a) Phoneme scoring:** If Phoneme scoring is selected in the AC440 setup (see section Error! Reference source not found.), mouse click on the corresponding number to indicate phoneme score.

b) **Store:** A mouse click on this button will store the speech threshold in the speech graph.

**Frequency and Intensity display area:** On the left side of the black area the dB value for Channel 1 is shown and on the right side for Channel 2. In the middle of the black area the current Speech Score in % and the Word Counter monitors the number of words presented during the test.
9.3.1 Speech Audiometry in Graph Mode
The following section describes the elements of the speech screen in graph mode.

1) **The graph:** The curves of the recorded speech graph will be displayed here. The x-axis shows the intensity of the speech signal and the y-axis shows the score in percent. The percentage is also displayed in the black display in the upper part of the screen together with a word counter.

![Graph Screen](image.png)

2) **Norm curves:** The norm curves illustrate norm values for S (Single Syllabic) and M (Multi Syllabic) speech material respectively. These curves can be changed individually according to the preference of the clinician and the chosen speech material in the AC440 Setup.

3) **The shaded area:** The shaded area illustrates how high intensities the system will allow. The *Extended Range +20 dB* button may be pressed to go higher. Both are determined by the transducer calibration.

4) **Graph mode settings/Presentation - channel 1 and 2:** In the graph mode settings in the lower left corner and in the presentation options in the upper part of the screen the clinician can adjust the test parameters during the test.
9.3.2 Speech Audiometry in Table mode

The following section describes the elements of the speech screen in table mode.

The AC440 Table mode consists of two tables:

1) The **SRT** (Speech Recognition Threshold) table. When the SRT test is active the label will be orange SRT.

2) The **WR** (Word Recognition) table. When WR1, WR2, or WR3 is active the corresponding label will be orange WR.

![Screenshot of the speech audiometry screen]

9.3.2.1 The SRT Table

The Speech Reception Threshold table allows for measuring multiple SRTs using different parameters, e.g. Transducer, Test Type, Intensity, Masking, and whether or not the test is performed Unaided or Aided. In the Table mode settings in the in the lower left corner and in the Presentation – channel 1 and 2 options in the upper part of the screen the clinician can adjust the test parameters during the test.

Click on the Store button to store
Upon changing Transducer, Masking, and/or Aided and re-testing an additional SRT entry will appear in the SRT table. This allows for multiple SRT measurements to be shown in the SRT table. When more than 4 tests are made scrollbars will appear.

<table>
<thead>
<tr>
<th>Transducer</th>
<th>Test Type</th>
<th>Intensity</th>
<th>Masking</th>
<th>Aided</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRT</td>
<td>HL</td>
<td>30</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HL</td>
<td>10</td>
<td>15</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>HL</td>
<td>10</td>
<td>15</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>HL</td>
<td>30</td>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

9.3.2.2 The WR table

The Word Recognition table allows for measuring multiple WR scores using different parameters (e.g. Transducer, Test Type, Intensity, Masking, and whether or not the test is performed Aided). In the Table mode settings in the lower left corner and in the Presentation – channel 1 and 2 options in the upper part of the screen the clinician can adjust the test parameters during the test.

Click on the Correct, Incorrect, and Store buttons to score the test.

If selected use the Phoneme scoring

Upon changing Transducer, Masking, and/or Aided re-testing an additional WR entry will appear in the WR table. This allows for multiple SRT measurements to be shown in the SRT table. When more than 4 tests are made scrollbars will appear.

<table>
<thead>
<tr>
<th>Transducer</th>
<th>WR</th>
<th>Intensity</th>
<th>Masking</th>
<th>Score</th>
<th>Aided</th>
</tr>
</thead>
<tbody>
<tr>
<td>WR1</td>
<td>WR1</td>
<td>55</td>
<td>85</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WR2</td>
<td>WR1</td>
<td>55</td>
<td>95</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Binaural</td>
<td>WR2</td>
<td>55</td>
<td>100</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Left</td>
<td>WR3</td>
<td>50</td>
<td>90</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Binaural</td>
<td>WR3</td>
<td>50</td>
<td>75</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
9.4 Working with Individual Setups

There are many different demands and wishes regarding how an audiometer should both function and appear depending on the specific situation and national standards. One of the greatest advantages of the AC440 module is the flexibility enabling the individual clinician to tailor the system according to their specific preferences.

This section describes testing using both the pre-programmed standard protocols and how to create individual protocols for different purposes or different clinicians working in the same facility.

9.4.1 Selecting a (standard) test:

Open the Software Suite from Noah, OtoAccess™, or stand-alone. The system will automatically start in the AC440 module as indicated by the tab in the upper right corner of the screen as shown below:

When having opened the AC440 Module from Noah, OtoAccess™, or the stand-alone mode the clinician is ready to start measuring. The software is pre-programmed with standard protocols that can be selected from the front screen in the List of pre-programmed protocols dropdown list. This simplifies the testing for people not yet acquainted with the module.

9.4.2 Designing your own test:

To create a personalized test, enter the AC440 Setup menu which will be described in the following sections.

9.4.2.1 About the AC440 Setup

When having entered the AC440 Setup as described in section 9.4.2.2 all the AC440 tests will be listed to the left. The possibilities of each test can be viewed by clicking the small + next to it. This will prompt a menu containing:
- **Startup**: These settings are only used when choosing a new test setup or when the module is started. Note, however, that the test for which the startup is configured needs to be selected as *Start Screen* under *Common* options (see section 9.4.3).

- **Common**: Allows for setting up more general settings of the specific test

The following sections describe the setup options for all tests even though the clinician most likely will only need to setup a few. The section is therefore to be seen as a work of reference where single functions can be looked up rather than a step-by-step guide.

**Note**: Some setup screens contain more than one tab offering multiple user controls.

In every Setup screen the clinician will find three buttons in the lower right corner.

- **OK**: Clicking **OK** will close the AC440 Setup and save all changes made.

- **Cancel**: Clicking **Cancel** will close the AC440 Setup without saving any changes made.

### 9.4.2.2 Entering the AC440 Setup

1) Click **Menu**, choose **Setup** followed by **AC440 Setup** as illustrated below.
2) Selecting *AC440 Setup* opens the *Main setup* as shown below. The section to the left allows the clinician to navigate through the various test settings.

9.4.3 Setting up the Common options

1) The specifics of the test can now be selected starting in the *Common* screen shown below:

2) Choose the desired **Start Screen**.

3) Select the default **Intensity (Tone, Speech)**. Use the dropdown lists to select the preferred **Intensity steps** to be used when performing the audiology, the **Default intensity when changing output**, the **Ch2 start intensity** which determines the start intensity for Channel 2 when the channel is switched from off to on, and the **Ch2 intensity when changing frequency** which forces the channel automatically to select a certain intensity when the frequency is changed.
4) In the **Automatic output selection** the *Ch 2 opposite Ch 1 output* can be ticked. This way Channel 2 will automatically choose the opposite output as Channel 1 (e.g., if Channel 1 is set to *Right*, Channel 2 will automatically select *Left*). **Bone masking:** *Insert masking* will be grayed out until *Ch 2 opposite Ch 1 output* is ticked. This ensures that when *Bone* is selected as output for Channel 1 *Insert Masking* will automatically be chosen as masking for Channel 2.

5) Adjust the **Pulse** of the test signal. If *Multi Pulse* is ticked in the Tone/Speech screen or in the AC440 Setup. The pulsation length (in mS) can be adjusted in the upper slider. If *Single Pulse* is ticked in the main screen like in the example to the right the pulsation length can be adjusted in the lower slider.

6) Set **Talk forward** to the desired intensity using the slider. To allow talk forward in Free Field tick the check box just below the intensity slider. Below the clinician will find the **Talk forward input calibration**. When ticked the clinician will be able to adjust talk forward input level to 0 dB VU. This is helpful if the talk forward microphone is always located at the same position.

7) If desired, allow **Monitor** on live voice speech. This function is rarely necessary as it is likely to cause acoustical feedback. However, if the clinician is certain that the test is performed under circumstances where this is not the case monitoring of live voice can be allowed by ticking the check box.

8) Under **Settings – representation** tick *Show maximum intensities*. This will allow for showing/not showing the transducer maximum intensities (that is, the shaded area on the graph).
9.4.3.1 Setting up for Tone testing

Startup

1) To enter the *Startup* options for tone testing unfold the *Tone* options and click *Startup*.

![Image of Startup options]

2) Default *Output* of Channel 1 and Channel 2 can be selected in the two dropdown lists in the upper part of the screen.

   ![Channel 1 and Channel 2 dropdown lists]

3) The *Talk back* can be activated by ticking the check box. The level of the talk back can be adjusted on the slider. A normal audible level would be approximately 60 dB.

Common:

4) To enter the *Common* options for tone testing unfold the *Tone* options and click *Common*. Here the clinician is allowed to adjust some of the more frequent tone settings. Note that this screen contains two tabs (*General* and *Tone audiometry*) and starts up in *General*.
5) Default input for **Channel 1** and **Channel 2** can be set using the dropdown lists. Select between *Tone*, *Warble tone*, *NB* (Narrow Band noise), and *WN* (White Noise) as input for Channel 1, and *Tone*, *Warble tone*, *NB* (Narrow Band noise), *WN* (White Noise), and *TEN Noise* (if purchased) as input for Channel 2.

6) Set the **Presentation – channel 1** and **Presentation – channel 2**. The clinician has the option to tick *Manual* and thereby present the signal to the client only when the stimulus corresponding channel is activated. Ticking *Reverse* will cause the signal to be presented continuously, only disappearing when the stimulus of the corresponding channel activated. The clinician also has the option to select between *Single Pulse* and *Multi Pulse* presentation for Channel 1. The duration of the stimulus can be adjusted in the common options described above. Furthermore the clinician may wish to have presentation in both channels and tick *Simultaneous* which will lock channel 1 and channel 2 together or have the presentation in the two channels alternating to each other and tick *Alternate*.

7) Under **Monitor** one or both of the channels may be ticked if monitoring is preferred. The level of the monitoring can be set using the slider.
8) **Other settings** allow the clinician to tick *Aided* if audiograms usually are obtained with hearing aids and/or *Binaural* if both ears are tested at the same time. *HL* (Hearing Level), *MCL* (Most Comfortable Level) or *UCL* (Uncomfortable Level) may also be ticked depending on the preference of the clinician.

9) **Settings – controls** provides the option to tick *Ignore mouse over touch switch* which will make AC440 ignore the cursor touching the stimuli areas. The clinician will need to present the stimulus manually using the PC keyboard or the dedicated audiometer keyboard. To the right the clinician has the option to set the system for *Intensity decrease when changing frequency* using the dropdown list.

When ticking *Jump to 1 kHz by output change* the cursor will jump back to test 1 kHz upon output changes. The *Jump strategy* contains three different options:

<table>
<thead>
<tr>
<th>Strategy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Butterfly</td>
<td>The cursor will start at 1kHz and move upwards in frequency as the thresholds are obtained. After testing the high frequencies the cursor will move back to re-test 1kHz and move downwards. When jumping back to 1kHz the Butterfly strategy can be set to start the re-test at either the default start intensity or the intensity of the first threshold.</td>
</tr>
<tr>
<td>Bottom up</td>
<td>The cursor will start at 1kHz and move upwards. When the high frequencies are tested the cursor will jump to the lowest test frequency and move upwards towards 1kHz.</td>
</tr>
<tr>
<td>None</td>
<td>Frequencies are changed manually using the arrow buttons in the main screen, the PC keyboard or the dedicated keyboard.</td>
</tr>
</tbody>
</table>

If testing with warble tones the frequency of the warble tones can be adjusted in the *Warble Frequency* slider. This may for example be helpful if testing client with tinnitus.
10) Under **Settings – representations** the AC440 can be set to **Show Ch1 and Ch2 in a single audiogram** which may be helpful for comparison purposes. The clinician also has the option to **Swap intensity keys on PC keyboard** and **Swap arrows on intensity buttons**. If none of these are ticked the AC440 the intensity buttons will function as illustrated below:

![Intensity button examples](image1)

- 3 = Decrease
- 4 = Increase
- 5 = Decrease
- 6 = Increase

If **Swap arrows on intensity buttons** is selected the AC440 will swap the arrows like illustrated below. This will make the cursor move down or when the arrow pointing down is pushed in the software.

![Arrows examples](image2)

If **Swap intensity keys on PC keyboard** is selected the AC440 will swap the arrows like illustrated below. This will make the cursor move down when the arrow pointing down is pushed on the PC keyboard.

![Keyboard examples](image3)

- 3 = Increase
- 4 = Decrease
- 5 = Increase
- 6 = Decrease
In Settings – representation the clinician also has the possibility to tick Show masking information on screen if the masking intensity for every threshold is to be visible on the screen below the audiogram. The clinician may choose to see the masking information for air conduction (AC), bone conduction (BC), free field (FF) and insert phones (IP).

If ticking Show masking cursor the cursor will be visible on the masking channel. This way the clinician will have a view of a cursor for both channels.

11) Using the options under the Tone audiometry tab the clinician can select the desired test frequencies for HL/MCL and UCL by ticking the preferred frequencies. Use the Check all or Uncheck all buttons to help if needed. If the unselected frequencies are not to be visible on the graph then also tick Hide unselected frequencies just below. This way only the selected frequencies will appear on the audiogram.

12) The Hearing loss index on audiogram allows for ticking Show European CPT-AMA index or Show PTA (Fletcher) index. The European CPT-AMA is calculated using the numbers from the table below which ensures that the different frequencies are weighted correctly. If selecting the PTA (Fletcher) index the clinician can choose the thresholds that should be included in the calculation. Otherwise these will be grayed out. The default setting will be 500, 1000, 2000, and 4000 Hz.

The PTA index also provides the option to add a certain level to the result using the dropdown list. This is useful as the PTA is often used to determine the start intensity for speech testing. If the clinician for example would like to start the speech test 15 dB above PTA this can be selected in the dropdown list:
9.4.3.2 Setting up for Speech Testing

Start-up

1) To enter the Startup options for speech testing unfold the Speech options and click Startup.
2) Select the default output of **Channel 1** and **Channel 2** in the two dropdown lists.

![Drop-down lists for Channel 1 and Channel 2]

3) Activate the **Talk back** by ticking the check box. The talk back level can be adjusted on the slider. A normal audible level would be approximately 60 dB.

**Common**

4) To enter the **Common** options for speech testing unfold the **Speech** options and click **Common**. This will allow the clinician to adjust some of the more frequent speech settings. Note that this screen contains four tabs (**General**, **Other**, **Link stimulus type**, to **WR curves**, and **Norm curves**) and starts up in **General**.

![Screenshot of the Main setup window]

5) Set the **Presentation – channel 1** and **Presentation – channel 2**. The clinician has the option to tick **Manual** and thereby present the signal to the client only when the stimulus corresponding channel is activated. Ticking **Reverse** will cause the signal to be presented continuously, only disappearing when the stimulus of the corresponding channel is activated. The clinician also has the option to select between **Single Pulse** and **Multi Pulse** presentation for channel 1. The duration of the stimulus can be adjusted in the common options (see section 9.4.39.4.3). Furthermore the clinician may wish to have presentation in both channels and tick **Simultaneous** which will lock channel 1 and channel 2 together or have the presentation in the two channels alternating to each other and tick **Alternate**.
6) The default input for **Channel 1** and **Channel 2** can be setup using the dropdown lists. Select between **Mic1, Mic2, CD1, CD2** and **Wave File** as input for Channel 1, and **Mic1, Mic2, CD1, CD2, WN (White Noise), and SN (Speech Noise)** as input for Channel 2. As CD and microphone are not automatically considered masking signals the clinician has the option to tick **Masking** below the Channel 2 input selection. This is useful if a CD is playing for example a party noise. Ticking the **Masking** check box will then ensure that the AC440 considers the CD input masking.

<table>
<thead>
<tr>
<th>Channel 1</th>
<th>Channel 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mic1</td>
<td>SN</td>
</tr>
<tr>
<td>Mic2</td>
<td></td>
</tr>
<tr>
<td>CD1</td>
<td></td>
</tr>
<tr>
<td>CD2</td>
<td></td>
</tr>
<tr>
<td>Wave File</td>
<td>WN</td>
</tr>
<tr>
<td></td>
<td>SN</td>
</tr>
</tbody>
</table>

7) In **Settings – representation** the clinician can choose between **Table Mode** and **Graph Mode** using the two check boxes. If the SRT (Speech Recognition Threshold) is to be visible on the speech screen **Show SRT on speech screen** can be ticked. If this is the case the SRT value is calculated based on the norm curve (the distance in dB from the point where the norm curve reaches 50% to the point where the speech curve reaches 50%). Note that the norm curves change based on the speech material. The clinician must therefore ensure that the stimulus is linked to WR1, WR2, and WR3. Otherwise the SRT will not be shown on screen. Learn how to Link Stimulus tab to WR curve later in this section.

8) If **Table Mode** is selected under Settings – representation, **Table mode settings** can be adjusted. The clinician can decide whether the testing should start with SRT, WR1, WR2, WR3, HL, MCL, or UCL. These can be set in the **Link stimulus types to WR curve** (see later this section). The clinician can decide whether the testing should start with WR1, WR2, WR3, MCL, or UCL.

9) If **Graph Mode** is selected under Settings – representation, **Graph mode settings** can be adjusted. These can be set in the **Link stimulus types to WR curve** (see later this section). The clinician can decide whether the testing should start with WR1, WR2, WR, MCL, or UCL.

10) Under **Measurement type** the clinician can tick **Aided** if audiograms usually are obtained with hearing aids and/or **Binaural** if both ears are tested at the same time.
11) Under **Monitor** one or both of the channels may be ticked if monitoring is preferred. The level of the monitoring can be set using the slider.

12) Adjust the **Input Levels** for the selected input.

![Image of settings screen]

13) Under the **Other** tab additional speech test functions are available.

14) **Settings – controls** allows for ticking **Ignore mouse over touch switch**. This means that AC440 will ignore the mouse touching the touch switch/stimuli area. The function is embedded to avoid accidentally presenting a stimulus by moving the mouse over the area. **Deactivate incorrect button** may also be ticked. This way the incorrect button will be removed. If **Reset speech score on intensity change** is ticked the score will return to zero when the intensity is changed. This is useful to avoid accidentally storing a measurement point in the speech graph which was measured over different speech levels. **Reset score on HL to UCL change** is to make sure that if the test is toggled from HL to UCL that the scoring will restart so that the UCL test does not build on the HL scoring. **Phoneme score scheme** will allow phoneme scoring during the speech test. The front screen will allow the clinician to specify if 0, 1, 2, or 3 phonemes are correctly repeated as illustrated below.

![Image of phoneme score scheme]

---

1 This may be useful if testing with wave files. In the wave file settings the clinician can set time limits so that after a certain period of time the word will be scored as incorrect. In this case the incorrect button is not needed.
If *Phoneme score* is ticked, *First word(s) for familiarization* may be marked and set using the dropdown list. These are used as test words so that the clinician can be assured that the client understands the test procedure. If for example set to 3, the first three words will not be calculated in the final score as these are test words. The preferred *Number of words* for the actual scored test can be typed in the small section below the check boxes. Note that this will be ignored when using wave files as the number of words in this case will be dependent on the selected speech material.

15) **User defined WR comments** may be labeled if preferred. This function allows the clinician to name or label the speech material which will then be selectable for the print layout.

16) **Under the Link stimulus to WR curve** tab a certain type of speech material can be linked to the individual WR curves. If a clinic always uses a certain material on for example WR1 or WR2 then this gives the clinician the option to save the material type information along with the data.

17) To link a type speech material to the WR curves mark the desired speech material in the selection list to the left, such as for example *Single syllabic number* as illustrated in the example above, and click the arrow pointing towards the WR curve to which the material should be linked, for example *WR1*. *Single syllabic number* will then jump to *WR1*.
18) To unlink a selected type of speech material from an WR curve, such as for example *Sentence* from WR3 as illustrated above, mark the material and click the arrow pointing back to the selection. *Sentence* will then jump back to the selection list and a new type of speech material can be chosen for WR3.

19) Under the **Norm curves** tab the norm values appearing in the speech graph can be changed.

20) For **Phone norm curves** both *Multi syllabic* and *Single syllabic* norm values for speech tests obtained with head phone can be changed. The clinician is free to replace the exciting values with other norm material.

21) For **FF norm curves** both *Multi syllabic* and *Single syllabic* norm values for speech tests obtained in free field can be adjusted according to the preference of the clinician. The existing values can at any time be replaced with other norm material.